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2.3 LILLIEFORS UYUM İYİLİĞİ TESTİ 

Normal dağılıma uyumun anlamlı olup olmadığını göstermede kullanılan bir uyum iyiliği 

testidir. Eğer hipotezde öngörülen normal dağılımın parametreleri bilinmiyorsa ve bunlar örnek 

verisinden tahmin ediliyorsa normal dağılıma uyumun anlamlılığı testinde Lilliefors testinin 

kullanılması tercih edilmektedir. Test işleminin algoritması: 

i) Hipotezler kurulur 

a) 𝐻0:  Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur 

   𝐻1: Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir   

ii) 𝑛 birimlik örnek 𝑋1, 𝑋2, … , 𝑋𝑛 olmak üzere, 𝐻0 hipotezinde öngörülen normal dağılımın 

parametreleri tahmin edilir. 𝜇 parametresinin tahmin edicisi 𝑋 =
1

𝑛
∑ 𝑋𝑖

𝑛
𝑖=1  ve  𝜎2 

parametresinin tahmin edicisi 𝑆2 =
1

𝑛−1
∑ (𝑋𝑖 − 𝑋)

2𝑁
𝑖=1  dir. 

iii) 𝐻0 hipotezinde öngörülen normal dağılımın dağılım fonksiyonu bulunur. 

Söz konusu dağılım fonksiyonu belirlemek amacıyla önce örneğin sıralı istatistikleri oluşturulur 

ve ∀𝑥 için  𝐹0(𝑥) = 𝑃(𝑋 ≤ 𝑥) = 𝑃 (𝑍 ≤ 𝑧 =
𝑥−𝑋

𝑆
) değerleri bulunur. 

iv) Örneğin dağılım fonksiyonu bulunur. Lilliefors testinde örneğin dağılım fonksiyonu standart 

değerlere (𝑧) dayanır. Sıralı istatistiklere göre ∀𝑥 için 

𝑠(𝑥) =

(
𝑧′𝑒𝑒ş𝑖𝑡 𝑣𝑒𝑦𝑎 𝑑𝑎ℎ𝑎 𝑘üçü𝑘 𝑑𝑒ğ𝑒𝑟𝑙𝑖 

ö𝑟𝑛𝑒𝑘 𝑏𝑖𝑟𝑖𝑚𝑙𝑒𝑟𝑖𝑛𝑖𝑛 𝑠𝑎𝑦𝚤𝑠𝚤
)

𝑛
 

 

(2.7) 

şeklinde tanımlanır. 

v) Test istatistiği belirlenir.  

𝐹0(𝑥) sürekli ve 𝑠(𝑥) kesikli fonksiyon olduğundan Lilliefors testi için test istatistiği; 

𝐷 = 𝑆𝑢𝑝{|𝑠(𝑥𝑗) − 𝐹0(𝑥𝑗)| , |𝑠(𝑥𝑗−1) − 𝐹0(𝑥𝑗)| } (2.8) 

 

eşitliği ile verilir. 

𝐻0 hipotezi doğru iken 𝑠(𝑥) ve 𝐹0(𝑥) değerlerinin uyumlu ve böylece 𝐷 istatistiğinin küçük bir 

değer alması beklenir. Test istatistiğinin örnekten hesaplanan değeri 𝐷ℎ olsun. 

vi) Karar kuralı belirlenerek karar verilir ve yorumlanır. 

Test istatistiğinin örnekleme dağılımından yararlanarak 𝐻1 hipotezine göre 𝛼 önem seviyesinde 

karar kuralı belirlenir.  
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𝐻1’e göre 𝑠(𝑥) ve 𝐹0(𝑥) değerlerinin uyumlu olması beklenmez. Bu sebeple | 𝑠(𝑥) − 𝐹0(𝑥) | 

mutlak farklarının büyük çıkması ve test istatistiğinin de büyük bir değer alması beklenir. Bu 

büyüklük kriteri, 𝐷 istatistiğinin örnekleme dağılımından belirlenecek olan 𝐷𝑘 kritik değeridir. 

𝐷𝑘: 𝑛 ve 1 − 𝛼 için (𝑇6) tablo değeri olmak üzere: 

𝐷ℎ ≥ 𝐷𝑘  ise 𝐻0 ret edilir, 𝐷ℎ < 𝐷𝑘  ise 𝐻0 ret edilemez. 

Örnek 2.6 Bir sınıftan seçilen 25 öğrencinin istatistik dersinden almış oldukları notlar 

aşağıdadır. Bu notların dağılımının 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu olup olmadığına %5 önem 

seviyesinde Lilliefors testi ile karar veriniz? 

Not (𝑿𝒊): 60   40   45   90   70   40   40   70   90   80   70   70   20   10   20   80   60   40   70   90   

50   60   80   40   50 

Çözüm: Değişken(𝑋): Not (Puan)….. Nicel, sürekli ve ölçme düzeyi eşit aralıklı 

i) Hipotezler kurulur 

   𝐻0:  Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur 

   𝐻1: Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir   

ii) Örnekten yararlanarak 𝑁(𝜇 , 𝜎2) dağılımının parametreleri tahmin edilir. Örnekte 

tekrarlanan gözlemler olduğundan veriler düzenlenerek tekrarlı frekans veri düzeni oluşturulur 

ve düzenlenmiş veriden parametreler tahmin edilir. 

𝒙𝒋 𝒇𝒋 𝒇𝒋𝒙𝒋 (𝒙𝒋 − 𝒙) 𝒇𝒋(𝒙𝒋 − 𝒙)
𝟐
 𝒛𝒋 =

𝒙𝒋 − 𝟓𝟕, 𝟒

𝟐𝟐, 𝟔𝟗
 

𝒔(𝒙𝒋) 𝑭𝟎(𝒙𝒋) = 𝑷(𝒁 ≤ 𝒛𝒋) 

10 

20 

40 

45 

50 

60 

70 

80 

90 

1 

2 

5 

1 

2 

3 

5 

3 

3 

10 

40 

200 

45 

100 

180 

350 

240 

270 

-47,4 

-37,4 

-17,4 

-12,4 

-7,4 

2,6 

12,6 

22,6 

32,6 

2246,76 

2797,52 

1513,80 

153,76 

109,52 

20,28 

793,80 

1532,28 

3188,28 

-2,09 

-1,65 

-0,77 

-0,55 

-0,33 

0,11 

0,56 

1,00 

1,44 

1/25 

3/25 

8/25 

9/25 

11/25 

14/25 

19/25 

22/25 

1,00 

0,0183 

0,0495 

0,2206 

0,2912 

0,3707 

0,5438 

0,7123 

0,8413 

0,9251 

Toplam 1435  12356    

 

Örneğin veri düzeni tekrarlı frekans veri düzeninde olduğundan, 𝜇 kitle ortalamasının tahmin 

edicisi olan örnek ortalaması  

𝑋 =
1

𝑛
∑ 𝑓𝑗𝑋𝑗

𝑐
𝑗=1 =

1435

25
= 57,4  puan iken, 

𝜎2 kitle varyansının tahmin edicisi olan örnek varyansı 

𝑆2 =
1

𝑛−1
∑ 𝑓𝑗

𝑐
𝑗=1 (𝑋𝑗 − 𝑋)

2
=

12356

24
= 514,83 ve böylece st. sapması 𝑠 = √514,83 = 22,69 

olarak bulunur. 
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iii) 𝐻0 hipotezinde öngörülen normal dağılımın dağılım fonksiyonu ve örneğin dağılım 

fonksiyonu bulunur. 

𝒙𝒋 |𝒔(𝒙𝒋) − 𝑭𝟎(𝒙𝒋)| |𝒔(𝒙𝒋−𝟏) − 𝑭𝟎(𝒙𝒋)| 

10 

20 

40 

45 

50 

60 

70 

80 

90 

0,0217 

0,0705 

0,0994 

0,0688 

0,0693 

0,0162 

0,0477 

0,0387 

0,0749 

0,0183 

0,0095 

0,1006 

0,0288 

0,0107 

0,1038 

0,1523 

0,0813 

0,0451 

 

iv) Test istatistiğinin alabileceği değer hesaplanır. 

𝐷 = 𝑆𝑢𝑝{|𝑠(𝑥𝑗) − 𝐹0(𝑥𝑗)| , |𝑠(𝑥𝑗−1) − 𝐹0(𝑥𝑗)| } ….. 𝐷ℎ = 0,1523 

v) Karar kuralı belirlenerek karar verilir ve yorumlanır. 

𝛼 = 0,05, 1 − 𝛼 = 0,95 ve 𝑛 = 25 için (T6’dan) 𝐷𝑘 = 0,173 olup, 𝐷ℎ < 𝐷𝑘 olduğundan 𝐻0 

hipotezi ret edilemez. Buna göre mevcut örneğin dağılımı 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur. 

2.4 SHAPIRO WILK UYUM İYİLİĞİ TESTİ 

Normal dağılıma uyumlulukta yaygın olarak kullanılan uyum iyiliği testlerinden birisidir. 

İlgilenilen değişken nicel türden, sürekli ve en az eşit aralıklı ölçme düzeyine sahip olan bir 

değişken olmalıdır. Test işleminin algoritması: 

i) Hipotezler kurulur 

a) 𝐻0:  Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur 

   𝐻1: Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir   

ii) 𝑛 birimlik örneğe ait ortalamadan farkların kareleri toplamı hesaplanır. Örnek birimleri 𝑋1,

𝑋2, … , 𝑋𝑛 olmak üzere, ortalamadan farkların kareleri toplamı; 

 D=∑ (𝑋𝑖 − 𝑋)
2𝑛

𝑖=1   veya 𝐷 = ∑ 𝑓𝑗(𝑋𝑗 − 𝑋)
2𝑐

𝑗=1  eşitliklerinden uygun olanı ile 

hesaplanır. Burada 𝑋 =
1

𝑛
∑ 𝑋𝑖

𝑛
𝑖=1   veya 𝑋 =

1

𝑛
∑ 𝑓𝑗𝑋𝑗

𝑐
𝑗=1   ile bulunur. 

iii) Örneğin sıralı istatistikleri 𝑋(1) ≤  𝑋(2) ≤ ⋯ ≤ 𝑋(𝑛) oluşturulur ve test istatistiği belirlenir. 

Shapiro- Wilk testi için test istatistiği: 

 𝑊 =
1

𝐷
[∑ 𝑎𝑖(𝑋(𝑛−𝑖+1) − 𝑋(𝑖))𝑘

𝑖=1 ]
2
                                                                           (2.9) 
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ile verilir. Burada 𝑘 =
𝑛

2
 ve 𝑖 = 1, 2, … , 𝑘 için 𝑎𝑖 katsayılar (T7) bulunacak olan Shapiro- Wilk 

katsayılardır. Test istatistiğinin örnekten hesaplanan değeri 𝑊ℎ olsun. 

iv) Karar kuralı belirlenerek karar verilir ve yorumlanır. 

Test istatistiğinin örnekleme dağılımından yararlanarak 𝐻1 hipotezine göre 𝛼 önem seviyesinde 

karar kuralı belirlenir. 𝑃𝑟(𝑊 < 𝑊ℎ) = 𝑝 olmak üzere; 𝑝 < 𝛼 ise 𝐻0 hipotezi ret edilir,  𝑝 ≥ 𝛼 

ise 𝐻0 hipotezi ret edilemez. Burada 𝑝 olasılığı iki farklı yolla bulunabilir. 

I.yol: Test istatistiğinin örnekleme dağılımından yararlanarak yaklaşık olarak hesaplamak 

(T8.(a)) tablosu. 

Örneğin 𝑛 = 40 ve 𝑊ℎ = 0,93 olsun. 𝑃𝑟(𝑊 < 0,93) = 𝑝 diyelim. T8(a)’dan 𝑛 = 40 iken, 

𝑃𝑟(𝑊 < 0,928) = 0,02 ve 𝑃𝑟(𝑊 < 0,94) = 0,05 olup, buna göre 0,02< 𝑃𝑟(𝑊 <

0,93)<0,05= 𝛼, yani 𝑝 < 𝛼 dır. 

II.yol:  Dönüşüm yaparak test istatistiğinin örnekleme dağılımını standart normale 

dönüştürerek kesin olarak hesaplamak 

Örnek hacmi 𝑛 biliniyorken 𝑏𝑛, 𝑐𝑛 ve 𝑑𝑛 sabitler olmak üzere 𝑊 istatistiği üzerinde uygulanan  

 𝐺 = 𝑏𝑛 + 𝑐𝑛𝑙𝑛 (
𝑊−𝑑𝑛

1−𝑊
)                                                                                            (2.10)  

dönüşüm istatistiği için 𝐺~𝑁(0 , 1) dir. Burada 𝑏𝑛, 𝑐𝑛 ve 𝑑𝑛 sabitleri (T8(b))’den bulunabilir. 

Eşitlik (2,10) ile elde edilen değer 𝐺ℎ olmak üzere 𝑃𝑟(𝐺 < 𝐺ℎ) = 𝑝 olasılığı standart normal 

dağılımdan kesin olarak bulunabilir. 

Örnek 2.7 Bir sınıftan seçilen 25 öğrencinin istatistik dersinden almış oldukları notlar 

aşağıdadır. Bu notların dağılımının 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu olup olmadığına %5 önem 

seviyesinde Shapiro-Wilk testi ile karar veriniz? 

Not (𝑿𝒊): 60   40   45   90   70   40   40   70   90   80   70   70   20   10   20   80   60   40   70   90   

50   60   80   40   50 

Çözüm: Değişken(𝑋): Not (Puan)….. Nicel, sürekli ve ölçme düzeyi eşit aralıklı 

i) Hipotezler kurulur 

   𝐻0:  Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur 

   𝐻1: Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir   

ii) Örneğe ait ortalamadan farkların kareleri toplamı, örnek veri düzeni tekrarlı frekans veri 

düzeninde olduğundan Örnek 2.6’da 𝐷 = ∑ 𝑓𝑗(𝑋𝑗 − 𝑋)
2𝑐

𝑗=1 = 12356 olarak bulundu. 

iii) Örneğin sıralı istatistikleri ve test istatistiğinin alabileceği değer bulunur. 𝑘 =
𝑛

2
=

25

2
≅ 13 

 



25 
 

𝒙𝒋 𝒇𝒋 𝒊 𝒙(𝒊) 𝒂𝒊 𝑿(𝒏−𝒊+𝟏) − 𝑿(𝒊) 𝒂𝒊(𝑿(𝒏−𝒊+𝟏) − 𝑿(𝒊)) 

10 

20 

40 

45 

50 

60 

70 

80 

90 

1 

2 

5 

1 

2 

3 

5 

3 

3 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

10 

20 

40 

45 

50 

60 

70 

80 

90 

0,4450 

0,3069 

0,2543 

0,2148 

0,1822 

0,1539 

0,1283 

0,1046 

0,0823 

0,0610 

0,0403 

0,0200 

0,0000 

90-10=80 

90-20=70 

90-20=70 

80-40=40 

80-40=40 

80-40=40 

70-40=30 

70-40=30 

70-45=25 

70-50=20 

70-50=20 

60-60=0 

60-60=0 

35,600 

21,483 

17,801 

8,592 

7,288 

6,156 

3,849 

3,138 

2,0575 

1,220 

0,806 

0,000 

0,000 

Top. 25     107.9905 

 

Shapiro- Wilk testi için test istatistiğinin alabileceği değer: 

 𝑊ℎ =
1

𝐷
[∑ 𝑎𝑖(𝑋(𝑛−𝑖+1) − 𝑋(𝑖))𝑘

𝑖=1 ]
2

=
(107.9905)2

12356
= 0,944  bulunur. 

 iv) Karar kuralı belirlenerek karar verilir ve yorumlanır. 

𝐻1 hipotezine göre 𝛼 önem seviyesinde karar kuralı belirlenir. 𝑃𝑟(𝑊 < 𝑊ℎ) = 𝑝 olmak üzere 

𝑝 < 𝛼 ise 𝐻0 hipotezi ret edilir, 𝑝 ≥ 𝛼 ise 𝐻0 hipotezi ret edilemez. 𝑝 olasılığının belirlenmesi 

için iki yol mevcuttur. 

I.Yol: Yaklaşık hesaplama; 𝑛 = 25 ve 𝛼 = 0,05 iken (T8(a)) tablosundan 𝑝 = 𝑃𝑟(𝑊 ≤

𝑊ℎ) = 𝑃𝑟(𝑊 ≤ 0,944) =? 

𝑃𝑟(𝑊 < 0,931) = 0,10 ve 𝑃𝑟(𝑊 < 0,964) = 0,50 olduğundan 0,10 < 𝑝 < 0,50 yani 𝑝 > 𝛼 

elde edilir ve böylece 𝐻0 hipotezi ret edilemez. Buna göre Örnek verisinin dağılımı, 𝑁(𝜇 , 𝜎2) 

dağılımı ile uyumludur. 

II.Yol: Kesin hesaplama; 𝑛 = 25 iken T8(b)’den, 𝑏𝑛 = −5,704, 𝑐𝑛 = 1,876 ve 𝑑𝑛 = 0,2063 

olmak üzere 𝐺 istatistiğinin alabileceği değer; 

𝐺ℎ = 𝑏𝑛 + 𝑐𝑛𝑙𝑛 (
𝑊ℎ−𝑑𝑛

1−𝑊ℎ
) = −5,704 + 1,876𝑙𝑛 (

0,944−0,2063

1−0,944
) = −0,89 bulunur. 𝛼 = 0,05 ve  

𝐺~𝑁(0 , 1) olduğundan 𝑝 = 𝑃𝑟(𝐺 ≤ 𝐺ℎ) = 𝑃𝑟(𝐺 ≤ −0,89) = 1 − 0,8133 = 0,1867 olup, 

𝑝 > 𝛼 elde edilir ve böylece 𝐻0 hipotezi ret edilemez. Buna göre Örnek verisinin dağılımı, 

𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur. 
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2.5 SPSS’DE UYUM İYİLİĞİ ANALİZİ 

2.5.1  Ki-Kare Uyum İyiliği Testi Algoritması 

Spss’de Ki-Kare uyum iyiliği testini uygulayabilmek için takip edilecek algoritmanın adımları 

şu şekilde verilebilir. 

1.Adım Değişkenler ve özelliklerinin tanımlamaları yapılır. Variable View sayfasında 

sınıflama düzeyinde ölçülen değişkenin kategorileri (sınıfları) Values işlem penceresinde 

kodlanır. Gözlenen frekanslar için frekans değişkeni tanımlanır. 

2.Adım Frekans değişkeni ağırlıklandırılır. Bu işlem için Data > Weight Cases… seçenekleri 

sonucunda açılan ekranda Weight cases by seçeneği işaretlenerek frekans değişkeni 

Frequency Variable işlem kutusuna aktarılır. Ok tıklanarak ağırlıklandırma işlemi 

tamamlanmış olur, bu durumda Data View sayfasının sağ alt köşesinde Weight On uyarısı 

görülür. 

3.Adım I. YOL: Analyze > Nonparametric Tests > Legacy Dialogs > Chi Square…yolu 

izlenerek açılan ekranda değişkenler listesinde yer alan ve kategorileri gösteren değişken 

seçilerek Test Variable List işlem kutusuna aktarılır. Aynı ekranda bulunan Expected Values 

kutusundan uygun olan seçenek tercih edilir. Eğer tüm kategoriler eşit oranlarda tercih 

ediliyorsa All categories equal seçeneği, eğer sınıflara ait beklenen frekanslar belli ise Values 

seçeneği işaretlenerek aktif hale gelen pencereden sırası ile her bir sınıfa ait beklenen frekanslar 

girilir.  

Eğer sınıflara ait beklenen frekanslar bilinmiyorsa, SPSS yardımıyla hesaplanabilir. Beklenen 

frekansları hesaplamak için önce 𝑝𝑗 , 𝑗 = 1, 2, … , 𝑐 sınıf olasılıkları hesaplanır. Bunun için 

Transform > Compute Variable tıklanarak açılan pencerede Target Variable hücresine 𝒑𝒋 

yazılır. Sonra aynı pencerede Function group bölümünden PDF&Noncentral PDF seçeneği 

ve Functions and special variables bölümünden 𝐻0 hipotezinde öngörülen teorik dağılıma ait 

Pdf(öngörülen dağılım) seçeneği seçilir. Bu seçim bu bölümün sol tarafındaki boş hücrede 

görüntülenir. Görüntülenen bilgi aktarma butonu ile Numeric Expression işlem kutusuna 

aktarılır. Buraya aktarılan fonksiyonda bulunan soru işaretleri yerine istenen bilgiler girilir ve 

Ok tıklanır. Böylece 𝒑𝒋 olasılıkları hesaplanarak Data View sayfasında yeni bir değişken olarak 

görüntülenir. Beklenen frekansları hesaplamak için  Transform > Compute Variable 

tıklanarak açılan pencerede Target Variable hücresine 𝑩𝒋 yazılır. Sonra Numeric Expression 

işlem kutusuna 𝒑𝒋 × 𝒏 işlemi yazılarak 𝑩𝒋 = 𝒑𝒋 × 𝒏 denklemi kurulur ve Ok tıklanır. Böylece 

𝑩𝒋 beklenen frekansları hesaplanarak Data View sayfasında yeni bir değişken olarak 

görüntülenir. Hesaplanan beklenen frekanslar Values seçeneği işaretlenerek aktif hale gelen 

pencereden sırayla girilir. 

 4.Adım Ok tıklanarak işlem bitirilir, analiz sonuçları Output (çıktı) sayfasında tablolar 

halinde verilir. Tablolardaki bulgular değerlendirilerek “𝑝 < 𝛼 ise 𝐻0 ret edilir, 𝑝 ≥ 𝛼 𝐻0 ret 

edilemez” karar kuralına göre karar verilir ve yorumlama yapılır.  
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3.Adım II. YOL: Analyze > Nonparametric Tests > One Sample yolu izlenerek açılan 

ekranda Fields kutusu tıklanır ve açılan pencerede Fields bölümünden ilgilenilen değişken 

seçilerek Test Fields penceresine aktarılır. Setting kutusu tıklanır ve açılan pencerede 

Customize Tests işaretlenir ve açılan seçenekler içerisinden Chi-Square Test seçilir. Aktif 

konumdaki Options… kutusu tıklanır ve açılan pencerede, eğer tüm kategoriler eşit oranlarda 

tercih ediliyorsa All categories have equal probability seçeneği ve Ok tıklanır, önceki ekrana 

dönülür. Eğer sınıflara ait beklenen frekanslar belli ise Customize expected probability 

seçeneği işaretlenir ve Expected Probabilities işlem kutusunda Category kutusuna alt alta 

kategoriler ve karşılarındaki Relative Frequency kutusuna her bir kategoriye karşılık gelen 

beklenen frekanslar girilir ve Ok  tıklanır, önceki ekrana dönülür. Eğer sınıflara ait beklenen 

frekanslar bilinmiyorsa yukarıda açıklandığı şekli ile SPSS yardımıyla hesaplanabilir. 

Hesaplanan beklenen frekanslar Customize expected probability seçeneği işaretlenir ve 

Expected Probabilities işlem kutusunda Category kutusuna alt alta kategoriler ve 

karşılarındaki Relative Frequency kutusuna her bir kategoriye karşılık gelen beklenen 

frekanslar girilir ve Ok  tıklanır, önceki ekrana dönülür. 

4.Adım Run tuşu tıklanarak işlem bitirilir, analiz sonuçları çıktı sayfasında bir tabloda sunulur. 

Tablonun üzerine çift tıklandığı zaman detaylı analiz sonuçları grafik ve tablosuna ulaşılır. Bu 

grafik ve tablolara bakılarak bulgular değerlendirilerek “𝑝 < 𝛼 ise 𝐻0 ret edilir, 𝑝 ≥ 𝛼 𝐻0 ret 

edilemez” karar kuralına göre karar verilir ve yorumlama yapılır.  

2.5.2  Kolmogorov-Smirnov Uyum İyiliği Testi Algoritması 

I. Algoritma  

1.Adım Değişkenler ve özelliklerinin tanımlamaları Variable View sayfasında yapılır. Data 

View sayfasında her bir değişkene ait veriler girilir ve küçükten büyüğe doğru sıralanır. Aynı 

değerli gözlemler varsa bunlar tekrarlanan gözlem sayısı kadar alt alta girilir. 

2.Adım Analyze > Nonparametric Tests > One Sample yolu izlenerek açılan ekranda Fields 

kutusu tıklanır ve açılan pencerede Fields bölümünden ilgilenilen değişken seçilerek Test 

Fields penceresine aktarılır. Setting kutusu tıklanır ve açılan pencerede Customize Tests 

işaretlenir ve açılan seçenekler içerisinden Kolmogorov-Smirnov Test seçilir. Aktif 

konumdaki Options… kutusu tıklanır ve açılan pencerede uyum iyiliği testi uygulanacak 

dağılım seçilir. Dağılımın parametreleri / ortalaması örnek veri kullanılacaksa Use Sample 

Data seçeneği, bilinen parametreler / ortalama girilecekse Custom seçeneği işaretlenir ve ilgili 

kutulara bilinene parametreler / ortalama girilir. Ok  tıklanır, önceki ekrana dönülür. 

3.Adım Run tuşu tıklanarak işlem bitirilir, analiz sonuçları çıktı sayfasında bir tabloda sunulur. 

Tablonun üzerine çift tıklandığı zaman detaylı analiz sonuçları grafik ve tablosuna ulaşılır. Bu 

grafik ve tablolara bakılarak bulgular değerlendirilerek “𝑝 < 𝛼 ise 𝐻0 ret edilir, 𝑝 ≥ 𝛼 𝐻0 ret 

edilemez” karar kuralına göre karar verilir ve yorumlama yapılır.  
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II. Algoritma  

1.Adım Değişkenler ve özelliklerinin tanımlamaları Variable View sayfasında yapılır. Data 

View sayfasında her bir değişkene ait veriler girilir ve küçükten büyüğe doğru sıralanır. Aynı 

değerli gözlemler varsa bunlar tekrarlanan gözlem sayısı kadar alt alta girilir. 

2.Adım Analyze > Nonparametric Tests > Legacy Dialogs > 1-sample K-S…yolu izlenerek 

açılan ekranda değişkenler listesinde yer alan ilgilenilen değişken seçilerek Test Variable List 

işlem kutusuna aktarılır. Test distribution bölümünden uyum iyiliği testi uygulanacak dağılım 

seçilir. 

3.Adım Ok tıklanarak işlem bitirilir, analiz sonuçları Output (çıktı) sayfasında tablolar halinde 

verilir. Tablolardaki bulgular değerlendirilerek “𝑝 < 𝛼 ise 𝐻0 ret edilir, 𝑝 ≥ 𝛼 𝐻0 ret edilemez” 

karar kuralına göre karar verilir ve yorumlama yapılır.  

2.5.2  Normallik için Lilliefors ve Shapiro Wilk Testi Algoritması 

Adım:1 Değişken ve özellikleri tanımlanıp veriler girilir. Eğer birden fazla grup için aynı anda 

normallik testi uygulanacaksa, ayrıca grup değişkeni adı ile yeni bir değişken daha 

tanımlanmalıdır. Bu yeni değişken bir kategorik değişken olacağından, bu değişkene ait 

kategorilerinde Value bölümünde girilmesi gerekir.  

Adım:2 Analyze > Descriptive Statistics > Explore yolu izlenerek açılan ekranda ilgilenilen 

değişken Depent List işlem kutusuna aktarılır. Eğer birden fazla grup için aynı anda normallik 

testi uygulanacaksa grup değişkeni olarak tanımlanan kategorik değişken Factor List işlem 

kutusuna aktarılır. 

Adım:3 Plots seçeneği seçilerek açılacak olan ekranda Normality plots with tests seçeneği 

işaretlenir. 

Adım:4 Continue > OK diyerek işlem bitirilir. Sonuçlar bir tablo halinde Output sayfasında 

sunulur. Tablolardaki bulgular değerlendirilerek “𝑝 < 𝛼 ise 𝐻0 ret edilir, 𝑝 ≥ 𝛼 𝐻0 ret 

edilemez” karar kuralına göre karar verilir ve yorumlama yapılır.  

Örnek 2.8 Örnek:2.1-2.7’nin istenen çözümlerini SPSS programı ile yineleyiniz? Bulduğunuz 

sonuçları önceki çözümlerden elde edilen sonuçlarla karşılaştırınız? 

Çözüm: Örnek 2.1 Ki-Kare uyun iyiliği analizi: (I.Yol) 

𝐻0: Örnek, öngörülen kesikli düzgün dağılıma sahip kitleden çekilmiştir (Gözlenen frekanslar 

ile beklenen frekanslar uyumludur)  

𝐻1: Örnek, öngörülen kesikli düzgün dağılıma sahip kitleden çekilmemiştir (Gözlenen 

frekanslar ile beklenen frekanslar uyumlu değildir)  
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Hayvan Cinsi Observed 

N 

Expected 

N 

Residual 

muhabbet kuşu 50 28,0 22,0 

papağan 10 28,0 -18,0 

kedi 25 28,0 -3,0 

köpek 20 28,0 -8,0 

kanarya 35 28,0 7,0 

Total 140   
 

 

Test Statistics hayvancins 

Chi-Square 33,214a 

df 4 

Asymp. Sig.(p) ,000 

a. 0 cells (0,0%) have expected 
frequencies less than 5. 

 𝑝 < 0,05 olduğundan ise  𝐻0 ret edilir. 

 
 

 

Ki-Kare uyun iyiliği analizi: (II.Yol) 

 
 

𝑝 = 0.000 < 0,05 olduğundan ise  𝐻0 ret edilir. 

Örnek 2.2 Ki-Kare uyun iyiliği analizi: (I.YOL) 

𝐻0: Hastaların iyileşme süresine ait dağılım, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur (Gözlenen 

frekanslar ile beklenen frekanslar uyumludur)  

𝐻1: Hastaların iyileşme süresine ait dağılım, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir (Gözlenen 

frekanslar ile beklenen frekanslar uyumlu değildir)  

Eğer sınıflara ait beklenen frekanslar bilinmiyorsa, SPSS yardımıyla hesaplanabilir. Normal 

dağılıma uyumluluk testinde gruplandırılmış frekans verilerinde beklenen frekansları 

hesaplamak için önce 𝑝𝑗, 𝑗 = 1, 2, … , 𝑐 sınıf olasılıkları hesaplanır. Bunun için öncelikle sınıf 

sınırlarının standart değerleri bulunmalıdır. Orijinal sınıf sınırları için alt ve üst sınırları ayrı 

birer değişken gibi girilir ve bu sınırlar üzerinde standartlaştırma dönüşümü 𝒁 =
𝑿−𝝁

𝝈
 

uygulanarak sınıfların standart sınırları bulunur. Alt sınırlar (𝒁𝒂𝒍𝒕) ve üst sınırlar (𝒁ü𝒔𝒕) yeni 
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değişkenleri tanımlanır. Sonra hem alt sınırlar için hem de üst sınırlar için ayrı ayrı olasılık 

hesaplamaları yapılır. Alt sınırlar için hesaplanacak olasılıkları (𝒑𝒋𝟏)  ile üst sınırlar için 

hesaplanacak olasılıkları (𝒑𝒋𝟐) ile gösterelim. Bu olasılıkları hesaplarken izlenecek yol şu 

şekildedir.    Transform > Compute Variable tıklanarak açılan pencerede Target Variable 

hücresine 𝒑𝒋𝟏 yazılır. Sonra aynı pencerede Function group bölümünden CDF&Noncentral 

CDF seçeneği ve Functions and special variables bölümünden Cdfnorm seçeneği seçilir. Bu 

seçim bu bölümün sol tarafındaki boş hücrede CDFNORM(zvalue)… şeklinde görüntülenir. 

Görüntülenen bilgi aktarma butonu ile Numeric Expression işlem kutusuna aktarılır. Buraya 

aktarılan fonksiyonda bulunan soru işareti yerine 𝒁𝒂𝒍𝒕 girilir ve Ok tıklanır. Böylece 𝒑𝒋𝟏 

olasılıkları hesaplanarak Data View sayfasında yeni bir değişken olarak görüntülenir. Aynı yol 

izlenerek 𝒑𝒋𝟐 olasılıkları da hesaplanır. Daha sonra birinci sınıf için 𝒑𝒋𝟏 olasılığı 0 (sıfır) olarak 

ve son sınıf için 𝒑𝒋𝟐 olasılığı 1 (bir) olarak değiştirilir ve 𝒑𝒋 = 𝒑𝒋𝟐 − 𝒑𝒋𝟏 fonksiyonu 

uygulanarak istenen 𝒑𝒋, 𝒋 = 𝟏, 𝟐, … , 𝒄 olasılıkları hesaplanmış olur. Beklenen frekansları 

hesaplamak için  Transform > Compute Variable tıklanarak açılan pencerede Target 

Variable hücresine 𝑩𝒋 yazılır. Sonra Numeric Expression işlem kutusuna 𝒑𝒋 × 𝒏 işlemi 

yazılarak 𝑩𝒋 = 𝒑𝒋 × 𝒏 denklemi kurulur ve Ok tıklanır. Böylece 𝑩𝒋 beklenen frekansları 

hesaplanarak Data View sayfasında yeni bir değişken olarak görüntülenir. Hesaplanan 

beklenen frekanslar Values seçeneği işaretlenerek aktif hale gelen pencereden sırayla girilir. 

 

iyisüre 

 Observed N Expected N Residual 

3-7 2 13,4 -11,4 

7-11 130 129,6 ,4 

11-15 520 504,9 15,1 

15-19 796 804,1 -8,1 

19-23 516 504,9 11,1 

23-27 135 129,6 5,4 

27-31 1 13,4 -12,4 

Total 2100   
 

 

Test Statistics 

 iyisüre 

Chi-Square 22,196a 

df 6 

Asymp. Sig. ,001 

a. 0 cells (0,0%) have 

expected frequencies less 

than 5. The minimum 

expected cell frequency is 

13,4. 
 

 

(II.Yol) 

𝐻0: Hastaların iyileşme süresine ait dağılım, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumludur (Gözlenen 

frekanslar ile beklenen frekanslar uyumludur)  

𝐻1: Hastaların iyileşme süresine ait dağılım, 𝑁(𝜇 , 𝜎2) dağılımı ile uyumlu değildir (Gözlenen 

frekanslar ile beklenen frekanslar uyumlu değildir)  
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𝑝 = 0.001 < 0,05 = 𝛼 olduğundan 𝐻0 hipotezi ret edilir. Yani hastaların iyileşme süresine ait 

dağılım 𝑁( 𝑋 = 17 , 𝑆2 = 16,18) dağılımı ile uyumlu değildir. 

Örnek:2.3 Ki-Kare uyum iyiliği (I.Yol) 

𝐻0: Herhangi bir grupta iyileşen hasta sayısının dağılımı 𝐵𝑖𝑛𝑜𝑚(𝑘 = 5; 𝑝 = 0,95) dağılımı ile 

uyumludur 

 𝐻1: Herhangi bir grupta iyileşen hasta sayısının dağılımı 𝐵𝑖𝑛𝑜𝑚(𝑘 = 5; 𝑝 = 0,95) dağılımı ile 

uyumlu değildir 

 

Hasta 
 
Sayısı 

Observed 

N 

Expected 

N 

Residual 

 

,00 1 ,0 1,0 

1,00 5 ,0 5,0 

2,00 10 ,1 9,9 

3,00 50 2,1 47,9 

4,00 30 20,4 9,6 

5,00 4 77,4 -73,4 

Total 100   

 

 

 

Test 

Statistics 

hastasayısı 

Chi-Square 28253,518a 

df 5 

Asymp. Sig. P=0,000 

a. 4 cells (66,7%) have expected 

frequencies                 less than 5.  

Beklenen frekansı 5’den küçük olan 

sınıfların birleştirilmesi gerekir. Bu 

işlemden sonra analiz tekrarlanmalıdır. 

𝑝 < 0,05 olduğundan ise 𝐻0 ret edilir. 
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Örnek:2.4 (ALGORİTMA-I) parametreler biliniyor 

 
 

 

Örnek:2.5 (ALG-II) 

One-Sample Kolmogorov-Smirnov Test (Parametreler bilinmiyor) 

 ağırlık 

N 20 

Normal Parametersa,b 
Mean 2,4000 

Std. Deviation ,50498 

Most Extreme Differences 

Absolute ,124 

Positive ,124 

Negative -,100 

Kolmogorov-Smirnov Z ,554 

Asymp. Sig. (2-tailed) ,919 

a. Test distribution is Normal.  b. Calculated from data. 

) 

 

 

𝑝 = 0,478 > 0,05 𝑣𝑒𝑦𝑎 (𝑝 =
0,919

2
= 0,460 > 0,05)  𝑜𝑙𝑑𝑢ğ𝑢𝑛𝑑𝑎𝑛 𝐻0 ret edilemez 
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Örnek:2.5 (ALG-I parametreler bilinmiyor) 

 

 

𝑝 =
0,919

2
= 0,460 > 0,05, 𝐻0 olduğundan ret edilemez 

 

Örnek: (2.6-2.7) 

Tests of Normality 

 Lilliefors Testi Shapiro-Wilk Testi 

Statistic df Sig.(p) Statistic df Sig.(p) 

puan ,151 25 ,147 ,945 25 ,197 

𝑝 > 0,05 olduğundan 𝐻0 ret edilemez. 
 


